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Skit-Megal6

ATmegal6 Microcontroller Starter kit

This is a powerful AVR microcontroller starter kit. This kit is based on the ATMegal6
microcontroller. This board includes 1/0O ports, LCD Display Board, an in-system program-
mer and some interface modules. Learn and Teach with this high-end 8-bit microcontroller
kit.

Includes :
e VX-Megal6 Microcontroller board,
e PX-400 ISP programmer with cable
e ZX-LED output module x 3
e ZX-Switch module x 2
e ZX-Speaker module
e +9Vdc adaptor

e CD-ROM and Documentation

1. VX-Megal6 : ATmegal6 microcontroller board

1.1 Features

e Support ATmegal6/32/8535. On-board includes ATmegal6 Flash memory of 16KB
(expandable to 32KB with ATmega32)

o Clock rate of 16MHz

e |/O port of microcontroller are in 100 mil socket and INEX’s standard PCB-3 pin
connector.

e Expanable Display I/0O extension board includes the LCD16x2 module, 3 of Push
button switch, a Knob and Serial port interface circuit which is placed on top of Main
microcontroller board.

e 7-ch. Analog input with 10-bit Analog to Digital Converter
e Support In-system Programming via ISP connector with PX-400 Programmer

e Supply voltage +9V from external. +5V 500mA on-board regulator.
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Figure 1 Layout of VX-megal6 microcontroller includes the Display I/O board
plugged on-top in above and only the main board’s layout in bottom.
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Figure 2 shows the schematic of VX-magal6 main board
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Figure 3 shows the schematic of VX-magal6 display I/O board
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1.2 Circuit description

In Figure 2 and 3, this shows the full schematic diagram of both boards in VX-megal6
microcontroller board. The main microcontroller circuit shown in the Figure 2 and Display
I/0 in Figure 3.

The main device is the ATmegal6 microcontroller. Itis the AVR microcontroller from
Atmel. Operates with 16MHz clock frequency from external crystal. The main board sup-
ports all I/0 pin at connector K4 and 3-pin PCB connector at J1 to J21.

Wide range DC power supply is +9 to 16V. It has a +5V regulator IC for converting
the supply voltage to +5V for all supplying circuits.

Programming the program memory in the ATmegal6 must be work via In-System
Programming connector (ISP) with external ISP programmer such as INEX’s PX-400 and
AVRISP programmer. User must purchase separately.

At the Display I/0 board, interface with main board with plugable connector K4.
Port C of Atmegal6 will be assign to LCD pin interfacing. The Display I/0O has LCD16x2, 3 of
Push button switch with pull-up resistor, one of KNOB or variable resistor for analog source,
2 connectors port for 12C bus supporting, one of PA6 connector and RS-232 serial port
interface curcuit by MAX232 or ICL232 IC.

User can use only a Main board to experiment and/or plug the Displayl/O board
on top of main board for showing the data or mesaage on LCD screen, work with 12C bus
device and interface computer via RS-232 serial port (or COM port). The Figure 4 shows the
board connection.

(A) Show the board separated. The left is Dis- (B) This is the complete VX-magal6
play I/O board and Main board on the right. microcontroller board after plug-
ging both boards together.

Figure 4 Shows the board connection of VX-megal6 microcontroller board.
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1.3 VX-megal6 board’s cable assignment

The VX-megal6 board includes some sighal cables for the interfacing between the
controller board, sensor module and computer. The VX-megal6é comes with CX-4 serial
port interface cable and it need some of PCB3AA-8 cable for interconnection to the sensor
module and external application board and need a In-System Programming (ISP) cable

for interfacing the external programmer. However the ISP cable will supply with the pro-
grammer.

1.3.1 CX-4 serial port cable

This is used to connect between the computer’s RS-232 serial port and the target or
external device such as a Microcontroller board, eg. The VX-megal6 controller board. The
connector’s end uses a DB-9 female connector, and the other end uses a Modular plug RJ-
11 6P4AC (6-pins form and 4-contacts) Its Length is 1.5 meters. In the kit, this cable is used to
connect between the RS-232 serial port. The wire assignment is shown in the diagram below.

DB-9 female connector
© RJ11-6P4C modular plug

/ /
= /) / =
®

conductor side
@rd ()T @DTR (G)GND

OO 0O
°?997

1.3.2 ISP cable

This is a 10-wire ribbon cable. Both ends are attached to the female 10-pin IDC
header. It is used for interfacing between the ISP programmer box and Microcontroller
board at ISP connector. This ISP cable’s assignment is compatible with Atmel’s program-
ming tools standard. The wire assignment can be shown in the diagram below.

+5V MOSI
GND N/A
GND RST
GND SCK

GND MISO
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1.3.3 JST3AA-8 cable

This is INEX standard cable, 3-wires combined with 2mm.The JST connector is at
each end. 8 inches (20cm.) in length. Used for connecting between the microcontroller
board and all the sensor modules. The wire assignment can be shown in the diagram
below.

2mm. pitch

2mm. pitch
GNDL GND / / ]

s L S/Data s e
+5V -4 / Ju]
+5V /

1.4 Programming interface

In flash programming, VX-megal6 board needs the external In-system programmer;
PX-400. You must connect PX-400 with the computer via Serial or COM port. If your computer
has only USB ports, the USB to RS-232 converter is required to make the virtual COM port. At
the other end, connect with ISP connector on the target microcontroller board. See the
diagram below.

Direct connect to
Serial or COM port

CX-4 cable Connect to USB port

—

Connect to USB to Serial port converter if
your computer available only USB port
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About software tools in the flash programming of microcontroller, you can use 2
Software : AvrProg and Avr-OSP lll. In flash programming, you must connect the VX-megal6
board with PX-400 programmer and Serial port (or USB if using UCON-232S) and apply the
supply voltage ready first. After that open the programmer software.

You can see how to use these software in the PX-400 programmer documentation.

2. PX-400 Serial port In-System Progrmmer Box

2.1 Features

® Connects with the computer’s serial port via RS-232. If the computer has only a
USB port, a USB to SERIAL converter can be used. The UCON-232S is highly recommended
for this purpose.

® Program the AVR microcontroller via ISP cable. Supports Read, Write, Erase and
Protection functions.

® Requires +5V power supply from target/master board.

® Operates with the AVR Program software. This software is included in the AVR
Studio and can be found in the tools menu and works with the Avr-Ospll software as well.

Model Numbers of microcontroller supported in AVR Prog software

AT90S1200, AT90S2313, AT90S2323, AT90S2343, AT90S4433 , AT90S8515 , AT90S8535

ATmegal?8 , ATmegal6 , ATmegal6l , ATmegal62 , ATmegal63 , ATmegal6b4P ,
ATmegal6s , ATmegal68 , ATmega32 , ATmega64 , ATmega8 , ATmega8515 , ATmega8535 ,

ATtiny12 , ATtiny13 , ATtiny15L , ATtiny2313, ATtiny26

Model Numbers of microcontroller supported in Avr-OSP Il software

ATI90CAN128, ATO90OCAN32, ATO0OCANG4,
ATO0PWM2, ATOOPWM3,

AT90S1200, AT90S2313, AT90S2323, AT90S2343, ATI90S4414, ATO0S4433, AT90S4434,
AT90S8515, AT90S8515comp, AT90S8535, AT90S8535comp,

ATmegal0O3, ATmegalO3comp, ATmegal28, ATmegal280, ATmegal281l,

ATmegal6, ATmegal6l, ATmegal6lcomp, ATmegal62, ATmegal63, ATmegal6s,
ATmegal68, ATmegal69,

ATmega2560, ATmega2561,
ATmega32, ATmega323, ATmega325, ATmega3250, ATmega329, ATmega3290,
ATmegad06, ATmega4s,

ATmegab4, ATmega640, ATmegab644, ATmegab45, ATmega6450, ATmegab649,
ATmegab490,

ATmega8, ATmega8515, ATmega8535, ATmegass,

ATtiny11, ATtiny12, ATtiny13, ATtiny15,

ATtiny22, ATtiny2313,ATtiny24, ATtiny25, ATtiny26, ATtiny261, ATtiny28,
ATtiny44, ATtiny45, ATtiny461,

ATtiny84, ATtiny85, ATtiny861
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2.2 Software Installation

Programming in the AVR microcontroller development is in both C and Assembly
languages. The software that are installed for programming are the following :

(1) AVR Studio : This software tool is developed by Atmel Corporation. AVR Studio is
a Development Tool for the AVR microcontrollers. AVR Studio enables the user to fully
control execution of programs on the AVR In-Circuit Emulator or on the built-in AVR Instruc-
tion Set Simulator. AVR Studio supports source level execution of Assembly programs
assembled with the Atmel Corporation’s AVR Assembler and C programs compiled with
IAR Systems’ ICCA90 C Compiler for the AVR microcontrollers and WIinAVR open-source C
Compiler. AVR Studio runs under Microsoft Windows95 and Microsoft Windows NT. Now
Windows XP SP2 is recommended. Free download this software at www.atmel.com.

(2) WinAVR : WINAVR is a set of tools for the C compiler, these tools include avrgcc
(the command line compiler), avr-libc (the compiler library that is essential for avrgcc), avr-
as (the assembler), avrdude (the programming interface), avarice (JTAG ICE interface),
avr-gdb (the de-bugger), programmers notepad (editor) and a few others.

These tools are all compiled for Microsoft Windows and put together with a nice
installer program. Free download of the updated version is located at : http://
sourceforge.net/projects/winavr/.

User will need to install AVR Studio first and WIinAVR after which. AVR Studio’s mecha-
nism integrates automatically with WINAVR. With this feature, it assist the user in the devel-
opment of C language and programming on AVR Studio which is much easier and more
powerful compared to WIinAVR. The compiled file is a HEX file in which case, the user has
to download it into the program memory of the AVR microcontroller Board.

(3) Programmer software : This software is used to download the compiled .HEX file
to the AVR Microcontroller. Included in PX-400 programmer is the AVRProg and AVR-OSP II.
All software can work with PX-400 via Computer serial port.

(3.1) AVR Prog is Atmel’s software and an add-in feature in AVR Studio.

(3.2) AVR-OSP Il is created by Mike Henning. Download the latest version at
http://esnips.com/web/AtmelAVR

2.2.1 Installation of AVR Studio (based-on Window XP)

2.1.1.1 Insert the PX-400 CD-ROM and look for this file in the AVR Studio directory;
asStudio4b460.exe. Double-click on this file.
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2.1.1.2 Enter the Installation Wizard. Click on the Next button to continue.

AVRStudiod - InstallShield Wizard

w Welcome to the InstallShield Wizard for AYRStudiod
~ The

-«

o

2.1.1.3 In the license agreement window, Select the box : | accept the terms of the
license agreement and Click on the Next button.

AVRStudiod - InstallShield Wizard
nse Agreement

welcame to AYR Studio from Atmel Corparation,

Em level
‘execulion of Assembly and C/Ce+ programs assembled with the Atmel Corparation's included
/R Assembler of tools fiom 3rd party vendors.

soft windows35, Windows 98, Windows N, Microsoft
elows <P

4V/R Studin is continously develoning. In erder to get latest uporades of AV Studo, plezse
visit our web site

iy, atmel.com

and check out the AR page.

IastallShicld <Back HNest> Cancel

2.1.1.4 Choose Destination Location windows will appear. You can change the
path by clicking on the Change button and setting a new path. After this, click on the
Next button.

AVRStudiod - InstallShield Wizard

ose D

Irstal|5ield < Back. Canocel

2.1.1.5 The Driver USB Upgrade window will now appear. Click on the Next button
to pass this step.
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2.1.1.6 In the begin installation window, click on the Install button to start installa-
tion.

2.1.1.7 After the installation is complete, click on the Finish button to end the instal-
lation of AVR Studio.

2.1.1.8 To Launch the AVR Studio program, click on Start > Programs - Atmel AVR
Tools > AVR Studio 4. The main window of the AVR Studio program will appear.

“# AVR Studio (=1}
- File Project Build View Tools Debug Help

D I BEREC CEH M AE AR =E= > s T N BTFFLNEMNRA BEE
E Trace Disabled - % ¥ v[} L T ém m \Ez '\E? (D

I/ Wiew

Mame | Valuel Bits

B1jo view | @1nfo |
Message
Laaded plugin STKS00
I_[( ] I } [l]
326uld 4 Message | SRFind in Files ‘ @Breakpnints and Tracepoints
[ ] CAP UM SO JJ

2.2.2 Installation of WinAVR

Please note that installation of WinAVR is done after the installation of AVR Studio.
Please ensure this is being done before proceeding.

2.2.2.1 Insert the PX-400 CD-ROM, and find the installation file of WinAVR; WinAVR-
20050214-install.exe (or the newer version if appear). Double-click this file.

2.2.2.2 Installation language dialog box will appear for selection the language of
this installation. Select your preferred language from the sliding bar. After that click on the
OK button.

Installer Language |X|
@ Please select a language.,
T
I (a4 l ’ Cancel ]
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2.2.2.3 The Welcome installation software window appears and shows the installa-
tion information. Click on the Next button.

inAVR 20050214 Setup = B3

Welcome to the WinAVR 20050214
Setup Wizard

This wizard will guide vou through the installation of 'Wina R
20050214,

It iz recommended that you close all other applications before
starting Setup. This will make it possible to update relevant

system files withaut having ta reboat your computer

Click Mext to continue.

2.2.2.4 In the License agreement window, Click on the | agree button.

2.2.2.5 Choose Install Location window appears. User can change the path and
the folder for the installation of WinAVR by clicking at the Browse button and selecting the
respective folder. The proposed folder is C:\WIinAVR. After selection, click Next button to
continue to the next step.

2.2.2.6 In the Choose Components window, select the components which you want
to install or follow according to the below diagram. Click on the Install button to begin the
installation.

& WinAVR 20050214 Anka

 aannaulwvuued
\Aon Features o WindYR, 20050214 ¥k adiasnisdind @

Check the components you want to install and uncheck the components you don't want to
install. Click Install to start the installation.

a e g
LR oMU D MSHm [#]itg
[=RH

stall Files
[] add Directories ko PATH (Recommended)
[#] add Shartcuts ta Deskkop

[#] Install Programmers Motepad

wWoviidinarna: 71.6MB

< pauld ][ Gima 1 [ UALER

2.2.2.7 The installation process starts and reports the status back on the screen. The
User needs to wait until the installation is complete. Click on the Finish button to end once
its done.
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2.2.3 Installation of Programmer software
2.2.3.1 AVR Prog
It will install ready after instaaaltion AVR Studio.

2.2.3.2 Avr-Osp 1l 4.00 (or the latest version)

Copy the file AvrOspll_400.zip into the harddisk. Decompress the .zip file to
AvrOspll_400 folder. It contains 3 main files ; AvrOspll.exe, AvrOspll.ini and Devicelist.dat

3. Using Progframmer software
3.1 AVR Prog

3.1.1 Connect the PX-400 to Computer serial port and Target microcontroller board
with ISP cable. Apply the supply voltage.

) 7] ] Connect to RS-232
| x
. serial port directly*

@ RESET
RS-232 5P
Serial port

l —
Target ISP

© Reroy ISP cable

@ BUSY

PX-400 prog rammer

o3 @om--

AVR microcontroller Target board
Must apply the supply voltage at the
target board and connect all device
ready before open the software.

* If computer has not serial port, suggess to use USB to Serial port converter to
connect with computer. The UCON-232S is recommended.
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3.1.2 Open the Window explorer. Enter to find the AVR Prog execute file as :
C:\Program file\ATMEL\AVR tools\AvrProg\AvrProg.exe. Double clikc at this file. The
programmer’s window will appear.

=

Hex file

|D: Mok 2006%, . \default\LEDON. hex

Browsze. .. | Exit... |

—Flazh
| Frogram I W erify | Read |
—EEPROR
Frogram | W oerify | Read |
— Device
ATmegalk j Advanced.. |

3.1.3 If the connection fail, the warning dialogue box below will appear.

x
' Mo supported board Found!
. aYREprog version 1,40

K
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3.1.4 If allis correct, Click at the = &dvanced... | button at the main AVR Prog window to
set the configuration. Setting this will be done only once. Changing of the configurations
can be done subsequently as well. The Advance window will appear.

x

— Lock bitz

Mods 1 [BLBOMode 1 | |BLE1Mode1 v

|N|:| program lock features

— Fuze bits
¥ SFl Enable [~ OCD Enable
[~ BOOTRST [” JTAG Enable
[ EESAVE ™ Full amplitude
IE:-:t #TAL. High frequency j
IStartup: 1K CE. j

[NoBOD function  =| |Boot block 1024 twords = |

Read | Wrike | Chip Erase |

Device signature  [1E 94 03
T arget board EVH ISP

Target S rew. 3.8
Calibration byte Ot 7

3.1.5 Setting the configuration bit :
3.1.5.1 Set the Lock Bit to Mode 1 if you need to read the protected code
after programming.
3.1.5.2 Check the box SPI Enable (DO NOT UNCHECK !!lI)

If unchecked, the programming process will still continue. The programmed AVR
microcontroller will run but you will not be able to RE-PROGRAM THE CHIP WITH THE AVR
SOFTWARE. The only solution is to Re-program this bit with a High-Voltage Programmer such
as ALL-11, AVR ISP Mark Il etc.

3.1.5.3 Set to Oscillator mode. Normally this will set to Ext XTAL.High frequency
in connection to the external crystal to clock source. (Important; do not remove or change
unless are using another clock source).

3.1.5.4 Click Wwirite | button to store Configuration information.

3.1.5.5Click = ChipEraze | button for erasing the Program memory

3.1.5.6 Click button for finishing the Configuration setting.
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3.1.6 Open the HEX file by click at = Beowss.. | button.

3.1.7 Click __Erdram |for programming the HEX file to the microcontroller’s program
memory. The Busy red LED on PX-400 programmer lights until finish it will off. At the Progess
bar on AVR Prog software will show the status until finish too. Target microcontroller will run
immediatly.

The PX-400 programmer has 2 LED indicators as :

1. The green LED for Ready status: Inform that it is ready and supply voltage
status.

2. The red LED for Busy status: Lets the user know the programmer is still work-
ing. When red Busy LED light is blinking or on, the green Ready LED must be off.

3.2 Using Avr-Osp Il software

3.2.1 Connect the PX-400 to Computer serial port and Target microcontroller board
with ISP cable. Apply the supply voltage.

3.2.2 Open Avr-Osp |l software by double-click on AvrOspll.exe file. The main win-
dow wiill appear.

@ Avr-Osp |1 EJ

Program 1 Fuse Bitsl Lock Bits] .&dvanced] Eunfigure] Help ]

Device Auto program settings

]Nu device selected ﬂ Auto Detect l [ Erase device before programming

[ Werify device after programming

[ Send Exit after programming

[ Eraze Device] [ Auto l [ Send Exit ]
FLASH EEFROM
| |
[ Program ] [ Werify ] [ Fead l [ Program l [ Wity ] [ Read ]
FLA&SH Range EEPROM Range
Start; End: Start: End:
[ Ussrange  |000 [ I Userangs  |0w00 | 000

==z
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3.2.3 Select the Configuration tab to select the communication port and baudrate.
You need to set it to 115,200 baudrate only. The port is selected to Auto.

% Avr-Osp I EJ

F'ru:ugram] Fuze Bit$| Lock Bits | Advanced Configurs ] Help ]

Communication Setup General Settings

Port Baud

lsuto | [115.200 ~|

W Restore cunent settings on startup

¥ Prompt before programming fuses

3.2.4 Back to main window by selecting the Program tab. Click Auto Detect button
in Device box. Wait a moment to see the operation at Status box.

%2 Avr-Osp Il - ATmesgalé E]
Program ]Fuse Bits] Lock Bitsl Advanced Eonfigurel Help ]
Device Auto program settings
|&Tmegalb x| [Auto Detect } [ Erase device before programming

[ Werify device after programming

Flash =size = 15384

EEProm size = E1Z [ Send Ewit after programming

Page size = G54

Sgmtare S Uzls 0208 Usle [Era&e Device” At H Send E it ]
FLASH EEPROM

| |

[ Frogram l [ Werify ] [ Fead ] [ Program ] [ Werify l [ Fiead l
FLASH Range EEFROM Range

Start: End: Start: End:
[ Ussrange  |0x00 [ [ Userange  |0<00 [0=00

Checking programmer type ...
Found AVE ISP

Entering programming mode. ..
Signature = 0Ox1E 0Ox94 0x03
Leaving prograwming mode. . .

x=d(=—d

A Device box will show the number of AVR microcontroller with some infor-
mation. At the same time, the Status box will display much status and information
- Checking programmer type...
- Found AVR ISP

- Entering programming mode
- Signature = XXXX XXXX XXXX

- Leaving programming mode
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3.2.5 Select the Fuse Bits tab for reading the Configuration or Fuse bit of the AVR
microcontroller. Two parameters must not be change. See the figure below.

# Avr-Osp Il - ATmegal6 E]

Program Fuse Bits l Lock Bits] Advanced] Configure] Help ]

O On-Chip Debug Enabled; [OCDEN=0] LS
O 1TAG Interface Enabled; [ITAGEN=0]

B Serial program downloading (SPI) enabled; [SPIEN=0]

O Preserve EEPROM memory through the Chip Erase cycle; [EESAWE=0]

O Boot Flash section size=122 words Boot start address=f1F20; [BOOTSZ=11]

O Boot Flash section size=256 words Boot start address=$1F00; [BOOTSZ=10]

O Boot Flash section size=512 words Boot start address=$1E00; [BOOTSZ=01]

E Boot Flash section size=1024 words Boot start address=$1C00; [ROOTSZ=00] ; de
O Boot Reset vector Enabled (default address=$00000; [BOOTRST=0]

O CKOPT fuse {operation dependent of CKSEL fuses); [CKOPT=0]

O Browen-out detection level st WoC=4.0%; [BODLEVEL=0]

E Brown-out detection level atW2C=2.7 %, [BODLEVEL=1]

O Browen-out detection enabled; [RODEM=0] -
< >

W WV kWWIWIW Et |DFF
W VT W[ W Hghl0D3

p p |7 ,— p p |7 |— Low |0O<EE [ F'roglam l [ Vellf}'
Cl||Leaving prograwwing mods. .. s
L||checking programmer type ...
F||Found ave 157
Entering programming mode. .
C Fuse bits read = OxD3EE ( 1101100111101110 )
Leaving programming mode.
w*
# Avr-Osp Il - ATmegal6 E] .§

Program  Fuse Bits ] Lock Bits | Advanced | Configue | Help |

O Ext. Crystal/Resonator Medium Freq.; Start-up time: 1K CK + 4 ms; [CKSEL=1100 £ »
O Ext. Crystal/Resonator Medium Freq,; Start-up time: 1K CK + 64 ms; [CKSEL=1101
O Ext. Crystal/Resonator Medium Freq.; Start-up tirme: 16K CK + 0 ms; [CKSEL=1101
O Ext. Crystal/Resonator Medium Freq.; Start-up time: 16K CK + 4 ms; [CKSEL=1101
O Ext. Crystal/Resonator Medium Freq.; Start-up time: 16K CK + 64 ms; [CKSEL=110
O Ext. Crystal/Resonator High Freq.; Start-up time: 258 CK + 4 ms; [CKSEL=1110 SU
O Ext. Crystal/Resonator High Freq.; Start-up time: 258 CK + 64 ms; [CKSEL=1110 S
B Ext. Crystal/Resonator High Freq.; Start-up time: 1K CK + 0 ms; [CKSEL=1110 SUT
O Ext. Crystal/Resonator High Freq.; Start-up time: 1K CK + 4 ms; [CKSEL=1110 SUT
O Ext. Crystal/Resonator High Freq.; Start-up time: 1K CK + 64 ms; [CKSEL=1111 SU
O Ext. Crystal/Resonator High Freq.; Start-up time: 16K CK + 0 ms; [CKSEL=1111 SU
O Ext. Crystal/Resonator High Freq.; Start-up time: 16K CK + 4 ms; [CKSEL=1111 Sl
O Ext. Crystal/Resonator High Freq.; Start-up time: 16K CK + 64 ms; [CKSEL=1111 Slw
£ >
WV WFWWWFW Es |0FF
MWW W Highl0D3
MM W Low [DEE |_FProgam | [ veriy |

Cl|Leaving programming mode. . . e
L ||Checking programmer type ...

R [|Found AVE ISP

Entering programming mode. ..
Fuse bits read = OxDSEE { ll01100111101110

Leaving programming mode. .
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3.2.6 If you require Code protection, select the Lock Bits tab. Select the bit for
reading protection after programmed already.

2 Avr-Osp I - ATmegal6 [z]

Program] Fuse Bits  Lock Bits lAdvanced] Eonfigure] Help ]

B Mode 1: No memory lock features enabled

O Mode 2: Further programming disabled

O Mode 3: Further programming and ver ification disabled

B aApplication Protection Mode 1: Mo lock on SPM and LPM in Application Section
O aApplication Protection Mode 2: SPM prohibited in Application Section

O application Protection Mode 3: LPM and SPM prohibited in application Section
O application Protection Mode 4: LPM prohibited in Application Section

E Boot Loader Protection Mode 1: No lock on SPR and LPM in Boot Loader Section
O Boot Loader Protection Mode 2: SPM prohibited in Boot Loader Section

O poot Loader Protection Mode 3: LPM and SPM prohibited in Boot Loader Section
O Boot Loader Protection Mode 4: LPM prohibited in Boot Loader Section

rArArArArA A A = Pogiam | [ Veity | [ Read

C||Leaving programming mode. . . ~
L ||Checking programmer type _ ..
R ||Found ave 1zp
Entering programmibg mods. . .
c Fuse bits read = 0OxD2EE ¢ 1l01100111101110 )
5 Leaving programming mode. .

3.2.7 Select the Advance tab for checking the Signature of microcontroller by click-
ing at the Read button in Read Device Signature box for interfacing confirmation.

# Avr-Osp Il - ATmega16 E]

Program] Fuze Bits] Lock Bits  Advanced l Configure] Help ]

Fiead Device Signature

TWIE 004 Ow03

Ozcillator Calibration

Frequency Walue
10MHz | [088
& FLASH Address

" EEPROM

C||checking prograwmer type ... ~
L [|Founa ave 1sP
F||Entering programwming mods. ..

Beading 08CCAL from device

c 0xBE
P Leaving programming mode.
Y ~
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3.2.8 Back to Program tab, select the HEX file in Flash box.

3.2.9 At Auto Program Setting box, user can set the automatic programming to 3
steps as :

3.2.9.1 Erase devive before programming

3.2.9.2 Verify device after programming

3.2.9.3 Send Exit after programming

Suggess to select Erase devive before programming choice at least.

3.2.10 User can start the programming 2 methods. First, click at Program button in
Flash box or click the Auto button in the Auto program setting box. The progress bar will
active and Status box reports the operation status together.

# Avr-Osp Il - ATmegalé E]
Pragram IFUSE BitS] Lock Bits] Advanced] Eu:unfigure] Help ]
Device Auto program settings
|J‘f’tT"'IEEIEI'IE ﬂ Auto Detect [~ Eraze device befone progranmmming
[ Werify device aft i
AT erify device after programming
EEProm size = E1Z [ Send Exit after programming
Page size = G6d
SHgeetrre S DElE URde OElE [Erase Device][ Ao ][ Send Exit ]
FL&SH EEPROM
[C-\lbraty,_labhp050T\defaultypOE |
] [ Werify ] [ Fead ] [ Program l [ Werify ] [ Fead ]
FL&SH Range EEFROM Range
Stark; End: Start; End:

[ Userange  |0w00 | 000 [ Userange  |0w00 | 000
C||Leaving prograuming mode. . . .S
L||Checking programmer type ...

R ||Found AWR ISP
Entering programming mode. .
C Reading HEX input file for flash operations. ..
Programwming Flash contents. .. 0x0000 TO OxlD43
v

3.2.11 The limitation of Avr-Osp Il (in V4.00) is not being able to save the HEX file into
the harddisk and it cannot show the HEX data that it has programmed.
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4. ZX-SWITCH : Switch/Touch sensor module

The technical features of this module is :
e Use the high-quality push-button switch with square knob.

o If the switch is not pressed, DATA will have a logic value of “1” . Once the
switch is pressed, DATA will be connected to ground, and will result in a logic value “0”.

e Get the supply voltage from the Master/Main microcontroller board.
e The supply voltage range is +3 to +6V.
e A LED indicator.

e INEX Standard 3-pin PCB connector. Confort to use with INEX boards.

O

LED1 | Indicator

Signal output
s1 g P

{jjwitch %
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5. ZX-LED : Single LED output module

The technical features of this module is :
e 8mm. Single LED
e Active with logic “1” include driver on-board.
e Suitable supply voltage +3 to 5Vdc
e Interface with microcontroller and logic circuit.
e INEX Standard 3-pin PCB connector. Comfort to use with INEX boards.
e Available 5 colors (Red/Green/Yellow/Blue/White)

Q1
KRC102
(DTC114)
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6. ZX-SPEAKER : Plezo speaker module

The technical features of this module is :
e 32Q impedace Piezo speaker.
e Support signal in frequencty range 1kHz to 3kHz.
e The supply voltage range is +3 to +6V.

e INEX Standard 3-pin PCB connector. Confort to use with INEX boards.

K1
INPUT
— c1
N 10/16V
— /
|
SP1
" Piezo

speaker
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7. C programming development with AVR Studio and
WINAVR compiler

In actual fact, writing of the C program for the microcontroller is not the actual
code that is sent to the microcontroller’s program memory. The real data is in the machine
code which is being compiled from the written C code and compiled with the C Compiler
software.

The steps in C programming development are as follows:
(1) Write the C programs with the text editor / Project IDE that is provided.
(2) Compile the C code into assembly Code for the microcontroller

(3) The Assembly Code will be converted into Machine Code into HEX file
format.

(4) Download this code into the program memory of the microcontroller
(5) Run the microcontroller. Go back to step 1 if you have errors.

Steps (2) and (3) will not be shown as the C Compiler will do all of these in its
background.

After installing AVR Studio and WINAVR software, the library files are required to be
copied in order to support the VX-Megal6. The library files are contained in the CDROM
that is included in this kit.

In the C programming development platform in AVR Studio, developers need to
compile it into project file format. After the codes are being compiled into HEX file using
the same name as the project filename, the file is needs to be downloaded into the
ATMEGAS8 Microcontroller.

For example :
Name the project file to test_segment. After compiled, the result file is
test_segment.hex
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7.1 The AVR Studio V4.0 windows details

The figure below shows the main components in the main window of the AVR Studio
software.

File and Libraries that link with

the current project

4UR Studin - [pressuresemsore]. | UITENT file is under development

Eile Project Build Edit  Yiew Tools Deblg aoet
0= = = T Y » o
om o £ X
AVR GCC x #include <ipst hs j
= ﬂpressure_sensnr {default) A float P _abs{char analog channel)
=-23 Source Files

[£] pressurs_sensor.c Main C program file of this project '

0.55):

=9 Header Files

=124 External Dependencies
analag.h ‘{Jhlle(l)
ctype‘h led{"P(kPa): %f ".P_abs=i{l)):
5 in_out.h sleep(100);
interrupt.h >
interrupt. b I}
inttypes.h
in.h
iomL6.h
ipst.h
led.h
led.h
librm. a
mokar.h
portpins.h
segment.h

setial.h

L] sfr_defs.h
| frsef vildd 1| '
‘@AVR GCC | Belifo view | @ info pPressure_sensor.c q

3
Build x
~

Program: 7578 bytes (46.3% Full)
[.text + .data + .bootloader)

Build window : shows all status of operations which

includes the compiled result, error in compilation, HEX

Data: 40 bytes (3.8% Full)
[-data & .bas + .noinit) file size and any other warning messages.
Build succeeded with & Warnings... w
< >
-%Buwld @ Message | SRFRd in Flles @BreakpointsandTracapoints
@ ini4 i HLM

7.1.1 File menu

Includes the command as follows :

New File Create empty text file

Open File Open a file in text editor or an object file for debugging
Close Close the active text file

Save Save current text file

Save As... Save current text file under given name

Save All Save all files and project settings

Print Print active text file

Print Preview Preview active text file
Print Setup Setup printer

Exit Exit AVR Studio, project are saved when exiting.
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7.1.2 Project menu

Includes the command as follows :

Project Wizard

New Project

Open Project
Save Project
Close Project

Recent Projects

Open the project wizard.

You must close the current project first.

Open the new project dialog.

You must close the current project first.

Open a new project, either an APS project file or an object file.
Save the current project with all settings

Close the current project

Show a list of recent project, select one to open

Configuration Options This option is only available when the projectis a code writing

7.1.3 Build menu

project. E.g. an assembler or AVR GCC project. This com-
mand open the configuration dialog for the current project.

Includes the command as follows :

Build

Rebuild All
Build and run
Compile
Clean

Export Makefile
7.1.4 Edit menu

Build the current project

Rebuild all the modules in the project

Build, and if error free , start debugging session
Compile the current source file

Clean the current project

Save the current settings in a new make file

Includes the command as follows :

Undo

Redo

Cut

Copy

Paste

Toggle Bookmark
Remove Bookmarks
Find

Find in Files

Next Error

Show whitespace
Font and color

Undo last editor action

Redo any undo action

Cut and copy selected text from editor

Copy selected text from editor

Paste any text from clipboard to the editor

Toggle bookmark on/off at the selected line in the editor
Remove all bookmarks

Open a find dialog to search through the current source file.
Open a find in files dialog to search through all project files.
Locate and jump to the next build error if any

Toggle on/off whitespace markings

Open a font dialog to view/edit font settings in the source
editor
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7.1.5 View menu

This menu includes the command as follows :

Toolbars Sub menu toggles toolbars on/off, access to customize-dialog.
Described here

Status Bar Toggle status bar on/of (status bar is the line in the bottom of the
screen)

Disassembler Toggle on/off the disassembly window

Watch Toggle on/off the watch view
Memory Toggle on/off the memory view
Memory 2 Toggle on/off the memory view 2
Memory 3 Toggle on/off the memory view 3
Register Toggle on/off the register view

7.1.6 Tools menu

This is the hardware interfacing command menu. AVR Studio can interface many
hardware for development. For the VX-Megal6 board, developers must select the AVRprog.
This is the operating software for the PX-400 Serial Port In-System Programmer box.

Developers must connect the PX-400 box to their COM port before open the AVRprog
software.

7.1.7 Debug menu

This menu have many commands that relates to the program simulation and
debugging. The VX-Megal6 board does not require much usage of this feature.

7.2 Building C project file in AVR Studio

7.2.1 Open the AVR Studio. If there is any project running, developers can close by
select the menu Project - Close Project

7.2.2 To create the new project. Select the command at menu Project > New
Project.

O

hew Project

i F' 0 viey Open Project
— ﬂ Save Project
Name

Recent Projects  *
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7.2.3 The properties project window will appear. Set the parameter as follows :

7.2.3.1 Click on this to select AVR GCC item within Project type: for select
type of project file to program in C.

7.2.3.2 Set the project name as Switch_LED (an example name). This will cause
the initial file section to be created. This project has a main C program file called,
Switch_LED.c.

7.2.3.3 Select the project’s path in Location: Example is G:\Work2006\AVR-
ROBOT\Code. After this, click on the Finish button.

i~ Create new project -

Froject type: Froject name:
& Atmel &R Assembler ijitch_LED
%8 AVR GLT

¥ Create iritial fle 5 Ciecie iolder
Initial file:
|Switch_LED e

Location:
]G:\Work?DDB\AVH-HDBDT\Eode

Werd.12.452 W Show dialog at startup

< Back ‘ Mest > ‘E! Finizh ‘ LCancel ‘ Help ‘

7.2.4 The Switch_LED project environment will be created as shown in the diagram
below.

The folder Switch_LED will be created in G:\Work2006\AVR-ROBOT\Code. In
the same folder the file Switch_LED.aps and main C program file Switch_LED.c will be created.

7.2.5 Next step is to determine the microcontroller information and path of all the
library file which is being used in this project.

7.2.5.1 Select the command at Project > Configuration Options

AVR Studio - Switch_|ED.c

File | Project | Build Edit  ‘Wew Tools Debug  Window
2 Gy B Ep & x f9. AYRProg..

0@ Project Wizard
AR GE Mew Project

= f@ Cpen Project
+ Save Project
Close Project

Recent Projects L4

B Switch_LED.c

. Configuration Options
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After that the window Switch_LED Project Options will appear for setting
the properties. See the left of this window. Developers will found 5 icons as :

® General

® |nclude Directories

® Libraries

® Memory Settings

® Custom Options

7.2.5.2 At General icon, determine all data follows

® Device : atmegal6
® Frequency: 16000000 Hz

2O
Ryn s

General

—
Include
Directories
Libraries

g
L

Mermory Settings

'/f
F

Custom Optiur..'J

Switch_LED Project Options

)

Active Configuration |defau|t

j Edit Canfigurations

I Use Extenal M akefile |

|

Olutput File: Mame: | Gwitch_LED. &ff

Dutput File Directary: | defaults

Device: atmegal -

Fiequency:  |16000000

Optimization: -00

¥ Create Hex File

hz
Iv Pack Stucture Members [-fpack-stuct]
=
' iShat Enums (fshortenums]
™ Generate Map File ™ Gererate List File

e

¥ Unsigned Chars [-funsigned-char]
¥ Unsigned Bitfields [-funsigned-bitfizids]

oK | Cancel ‘ Help |

7.2.5.3 Click on this icon and the Include Directories for determining the path
of library file. Find and select the library file and click on the Add button. For example is
C:A\AVR_ROBOTMNinclude. After determining the path, you will found the list for selection.

7.2.5.4 Select the icon Libraries to links to all the libraries with the main file.

Switch_LED Project Options:

(S
R

General

Cirectories

&

Libraries

g
L

Memory Settings

)f
#

R Gp~

=
Include Directories
:&mm odores]

Include: Directaries

)

C:havr_robathiincluds’

TR

Femove

Mave Up
Move Down

0K

Cancel | Help |
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7.2.5.5 At the boxs , Available Link Objects:, click to select the item libm.a
and click the Right Arrow button to copy the item libm.a which appears at the Link with
These Objects window. Click the OK button to finish.

Switch_LED Project Options g|
:.?.73 . Library Directories
'y Add ..
s [r
General Remove
[~
Include 4
Directories
— Awailable Link Objects: Link with These Objects:
g libc.a Add Library -
libprintf_flt.a -
Libraries libprintf_min.a IR el
libzcant_flt.a
' libzcant_min.a
' ’ Add Object ..
Memory Settings
/r Move up
=
I Move down
Cuskam Optior_'_l
QK | Cancel Help

7.2.6 Next, write the C code in the Switch _LED.c file. TThis file controls the
microcontroller to On and off the LED when the switch is pressed. The details & codes of
this file is shown in the Listing 3-1.

7.2.7 Compile the target file to Switch_LED.hex by selecting the command at the
menu Build = Build or press F7 button or click at || button.

The status of this operation will be shown at the Build or Output window at
the bottom of the main window of the AVR Studio as shown in the diagram.

If any error occurs, such as an illegal command or a link error, the Build
Output window wiill appear. Developers need to edit the program,pfix all errors and re-
comple the code until it is correct and the HEX file is being compiled properly.

After compilation, the file Switch_LED.hex will be made and stored in the
folder of that project file. For example : The result file Switch_LED.hex is stored at the folder
Switch_LED.hex is stored at G:\Work2006\AVRROBOT\Code\Switch_LED\default.
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7.3 How to develop the previously project file

Developers can open the previously project file for editing or improvement. Enter
to menu Project > Open Project and select the path that store the target project file. The
project file is saved as .aps file

Example : If would like to open the Switch_LED project file, select to Project - Open
Project and access to the path or folder which contains the Switch_LED.aps file. Open this
file for editing. Developers can save with the same name or different.

7.4 Downloading and Testing the program

The next step after compiling the project file is to download the HEX file to
MicroCamp controlelr board. In this example the result file is saved as Switch_LED.hex. The
step of downloading and testing are as follows :

7.4.1 Turn on the POWER switch. The green LED at ON labeled is on.

7.4.2 Connect the download cable (ISP cable) from the PX-400 programmer box to
the In-System Prog. (ISP) connector on MicroCamp controller board.

7.4.3 Switch to AVR Studio program, select the command at menu Tool - AVR
Prog...

AYR Studio, - Switch_LED.c

File Project  Buld Edit  View | Tools | Debug  Window  Help

O = H ﬁ AYR Prog... [ |
ICESO Upgrade. ..

AR GCC x
= “E} Switch_LED {deFault) ICESD Selftest...
+-23) Source Files ITAGICE mkIl Upgrade. .. B Switch LED.c
AYRISP mkII Upgrade =

@ = g AVR Prog...

3 Header Files
—1-49 External Dependencies

#include <in_out. h
#include <=leep . h:»

in_out.h Custamize. .. wold main()

::;ypes'h Qptians... whils(1)

ioma.h Show Kew Assignments if (in d(2)=
|_ib_ltl.1j__ ) Plug-in Manager... { -

7.4.4 The AVRprog window will not appear.

7.4.5 At the AVRprog window, click on the Browse button to find the path of
Switch_LED.hex file for selection the HEX file require to download.

7.4.6 Click at the Program button in the Flash command. The Switch_LED.hex file
will now be downloaded into the ATmegal6 microcontroller in the VX-Megal6 board.

7.4.7 When the download is finished, the program will run automatic.

i
INNOVATIVE EXPERIMENT
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INNOVATIVE EXPERIMENT
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